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A. Overview 

 
This experiment uses HPLC-MS to determine the presence and quantity of three compounds (uric acid, 
6-aminouracil and allantoin; tyrosine is used as the internal standard) in urine. 
 
Suggested or required equipment used: 

 6520 Accurate-Mass Q-TOF HPLC-MS with an Agilent 1200 Series Binary Pump     

 Or Perkin Elmer single quad LC-MS 

 Cogent Diol™ column, 150mm x 2.1mm ID, 4µm particle size (MicroSolv Tech. Corp. Leland, 
North Carolina, US), Catalog number: 40060-15P (required) 

 
Note:  Other LCMS systems can be substituted for the ones described above, but the HPLC column is 
essential.  
 
B. Background 
 
Urine analysis is a non-invasive way to evaluate a person’s health. Allantoin, 6-aminouracil (6-AU) and 
uric acid (UA) are all compounds that have been detected in urine. UA is the end product of purine 
metabolism in humans and is discarded from the body by means of urine excretion. Although UA should 
naturally be present in everyone’s urine, a relatively high concentration of UA in urine may indicate UA 
build-up in the body and be cause for concern; higher levels of UA in the body can cause several 
diseases, like gout and kidney stones. Furthermore, detecting allantoin and 6-AU in urine may also have 
physiological implications since these compounds are not natural end products of human metabolic 
processes and have been detected at higher levels in patients suffering from various health problems 
(1,2].  
The Cogent Diol™ column is a unique column on the market which allows for retention and separation 
of the analytes of interest (allantoin, 6-AU and UA) using simple method conditions (without exotic 
mobile phase additives, or derivatization of the analytes) [3].  
The experiment is designed for forensic, biochemistry and chemistry students.  The LC-MS theory is part 
of the lecture and it is not covered in the description of the experiment.  The experiment should be 
treated as a base to develop an LC-MS experiment suited to individual teaching settings.   
Analysis of metabolities in synthetic urine samples was successfully done by San Jose State University 
students in the Chem 55L lab (Quantitative Analysis).   
 



 
 
 
 
Figure 1. Structures of the analytes from the study: A) Uric acid, B) allantoin, C) 6-aminouracil, D) triuret, 

and E) tyrosine (internal standard).  Please note that it was not possible to buy a triuret standard. 

 
 
C. Equipment and chemicals 
 

 6520 Accurate-Mass Q-TOF LC/MS with an Agilent 1200 Series Binary Pump SL or other LC-MS 
instrument 

 Cogent Diol column, 150mm x 2.1mm ID, 4um particle size, MicroSolv Tech. Corp. Leland, North 
Carolina, US, Catalog number: 40060-15P 

 Pure standards:  
allantoin (All), catalog number: 93791 
6-aminouracil (6-AU), catalog number: A50606 
uric acid (UA): catalog number: U2625 
D,L-Tyrosine (Tyr): catalog number: 145726 
were purchased from SigmaAldrich, US (SigmaAldrich.com) 

 Synthetic urine – 500 mL bottle,  
http://www.carolina.com/catalog/detail.jsp?prodId=695955&s_cid=ppc_products&utm_source
=google&utm_medium=cpc&s_cid=ppc_gl_products&scid=scplp695955&sc_intid=695955&gclid
=CPf_0fHriNECFUqSfgodFeoNDA 

http://www.carolina.com/catalog/detail.jsp?prodId=695955&s_cid=ppc_products&utm_source=google&utm_medium=cpc&s_cid=ppc_gl_products&scid=scplp695955&sc_intid=695955&gclid=CPf_0fHriNECFUqSfgodFeoNDA
http://www.carolina.com/catalog/detail.jsp?prodId=695955&s_cid=ppc_products&utm_source=google&utm_medium=cpc&s_cid=ppc_gl_products&scid=scplp695955&sc_intid=695955&gclid=CPf_0fHriNECFUqSfgodFeoNDA
http://www.carolina.com/catalog/detail.jsp?prodId=695955&s_cid=ppc_products&utm_source=google&utm_medium=cpc&s_cid=ppc_gl_products&scid=scplp695955&sc_intid=695955&gclid=CPf_0fHriNECFUqSfgodFeoNDA


 HPLC vials - MicroSolv Tech. Corp. Leland, North Carolina, US, 
         https://mtc-usa.com/Vials_Wisp.aspx 

 

 Volumetric flasks 

 Weighing bottles 

 Spatula 

 Centrifuge 

 1.5mL Microcentrifuge tubes 

 1000uL and 200uL micropipettes and tips 

 Analytical balance 

 HPLC-grade DI water/0.1% formic acid, formic acid, catalog number F0507 was purchased from 
SigmaAldrich, US (SigmaAldrich.com) 

 acetonitrile/0.1% formic acid 

 Syringes and syringe filters (Nylon 45 m) - (MicroSolv Tech. Corp. Leland, North Carolina, US), 
syringes follow link: https://mtc-usa.com/Luer-Lock-Syringes.aspx, filters follow link: mtc-
usa.com/wcode_filters_tech.aspx (Nylon, 4 mm filters were used)   
 

 
 
D. Notes for the instructors 
      
D.1 General notes 
 
Experiment takes one lab period (3 and one-half hours).  The pure standards were purchased from 
Sigma and the quantities are estimated to last for 1400 students. 
For practical purposes assign determination of one analyte per student.   
Have each student prepare their own calibration curve.   
As a pre-lab assign: 
1. Determination of m/z values for [M+H]+ ions for each analyte – have students create a table. 
2. Assign a calculation problem; for example: From mix of standards (1mg/mL) using micropipettes and 
HPLC vials prepare the following solutions for a calibration curve: 0.010 mg/mL, 0.020 mg/mL, 0.030 
mg/mL, 0.040 mg/mL and 0.050 mg/mL, each solution containing 0.1 mg/mL of tyrosine (internal 
standard [4]).  Have students WRITE A PROCEDURE (IN A TABLE) OF HOW TO PREPARE THE ABOVE 5 
SOLUTIONS FOR A CALIBRATION CURVE AND HAVE THE TABLE APPROVED BY THE INSTRUCTOR at the 
beginning of the lab.  Make sure that students will remember to include the unknown sample 
preparation in the table 
 
D.2 Accuracy of the student’s results 
 
    In Quantitative Analysis lab at San Jose State University students were given synthetic urine samples 
containing 0.015 mg/mL to 0.040 mg/mL of one analyte in the sample.  Students created two calibration 
curves: 
1. Peak area of the analyte vs concentration 
2. Ratio of peak area to Internal Standard peak area (tyrosine) vs concentration 
3. Students evaluated which calibration curve was better (higher R2 value in regression equation) and 
used this calibration curve to report results.  On average results were + 2.5 – 10 % different from the 

https://mtc-usa.com/Vials_Wisp.aspx
https://mtc-usa.com/Luer-Lock-Syringes.aspx


true value for 0.040 mg/mL samples and + 6.7 – 20% for 0.015 mg/mL samples.  About 60% of the 
students received scores between 70 – 99 points. 
 
D.3 Grading  
 
 The following grading scale was used  
 
 
 
 
 
 
 
 
 
 
 
 
Additional points of were assigned for selected calibration curve (for example R2 = 0.995 =- 1 point, etc)  
and report preparation  
 
D.4 Waste disposal 
 
During LC-MS runs most of the mobile phase is evaporated.  Make sure that there are traps installed to 
collect the organic solvent portion of the mobile phase. 
Collect all the extra solvents and analyzed sample solutions in a separate, labeled (according to your 
institutions requirements) waste container.  Remember to write the date of the start of the 
accumulation of the waste.  Keep waste containers in a secondary container (110% capacity of the 
original waste container).  
 
E. Procedures 
 

E.1 Preparation of Standard Solutions (LAB INSTRUCTOR) 
 
NOTE: steps below refer to preparation of the solution of allantoin, but the steps apply to any 
compound for which you wish to make a standard solution. 

 
1. Determine what standard concentration you’ll make for allantoin. It is recommended to prepare 

a  0.1mg/mL solution.  If you are using a less sensitive detector, please prepare 1 mg/mL 
solutions. 
 

2. Place a clean, dry weighing bottle on an analytical balance and tare the balance. Weigh as much 
allantoin as you need and record the weight.  
 

3. Transfer allantoin from the weighing bottle to a clean 100 mL volumetric flask. If necessary, use 
a Pasteur pipette and some DI water/0.1% formic acid to move any remnants of allantoin on the 
weighing funnel into the flask.  

 



4. Using a beaker, add about 50 mL of DI water/0.1% formic acid to the flask (please do not fill up 
the flask). Swirl the water around to dissolve all of the allantoin*.  

 
5. Fill the flask with DI water to the line. Cap the flask then invert and shake vigorously for a 

minute. 
  

6. This solution is your standard solution.  Store it in a refrigerator (at -20 °C). 
 

7. Repeat steps 1-5 for tyrosine, 6-aminouracil, and uric acid. Transfer all prepared solutions into 
clean glass containers with a lid.  Label containers with: Standard name, concentration, solvent, 
date of preparation, name of person who prepared solutions.  Dispose of the solutions after one 
year.  Place samples in the freezer until samples are ready to be used in the class.   

* If any of the compounds don’t dissolve completely in 100 mL room temperature water, prepare a water bath using a 

heating plate and 600mL beaker (you can use tap water for the bath). Hold the volumetric flask in a very warm bath to 
heat the solution. Remove the flask intermittently to shake up the solution. Continue heating and shaking until the 
compound has dissolved.  

 
If the compound will not dissolve when heated, you’ll need to start over and weigh out a smaller amount of the 
compound. If you start over, don’t forget to calculate what the concentration will be for your new standard solution. 

  
E.2 Internal Standard Calibration Curves [5] (STUDENTS) 

 
1. Use standard solutions prepared by Instructor to prepare at least 5 different calibration 

solutions for each target compound that each contain the same concentration of ISTD** 
tyrosine in our case (see Example 1 below for how to prepare different solutions of a compound 
that contain the same concentration of ISTD). You can approach this step in one of two ways: 

** ISTD – Internal Standard 
 

 Research Oxidative-Stress-Induced Target Compound Concentrations in Urine 
 
Look into the approximate amount of each target analyte found in the urine of people 
undergoing oxidative stress (e.g. 70-100 µg/mL of uric acid). Prepare at least 5 calibration 
solutions for each compound that encompass their compound’s concentration range in urine, 
e.g. a 30 µg/mL, 50 µg/mL, 70 µg/mL, 90µg/mL, and 110 µg/mL solution of analyte (uric 
acid, allantoin or 6 –aminouracil) would encompass the 70-100 µg/mL concentration range).  
Remember to add internal standard solution (the same concentration) to each calibration 
curve solution prepared. 

 
AND/OR 

 
 Research Similar Experiments and/or Determine Concentrations through Trial and Error 

 
Make a wide range of different concentrations for each calibration curve. Be sure to make at 
least one of the concentrations very dilute, and another highly concentrated, i.e. one of the 
concentrations should be close to the detection limit, and the other should be nearly as 
concentrated as your standard solution. Don’t worry if you haven’t a clue what the detection 
limit may be; research and/or guess what concentration may be near the detection limit and 
prepare that. If the compound from the dilute solution you make isn’t detected, make 
slightly more concentrated solutions until the compound is detected and can be analyzed. 



 
2. Run every calibration solution through HPLC-MS in triplicate. 

 

3. Using a data analysis program (e.g. MassHunter Qualitative Analysis), analyze each run to record 
peak areas for each calibration solution. 
 

4. Plot compound concentration by ratios of compound area to ISTD area to make calibration 
curves for each compound (like the one depicted below). You may notice from your data that 
area increases linearly with increasing concentration until a certain point… at which point, the 
areas start to plateau. Only use responses in your calibration curves that have a linear 
relationship with concentration. 

 
 

Figure 2. Example of calibration curve for uric acid 
 

 
Calculations Example 1.  
Problem: Using a 50 µg/mL concentrated standard solution of URIC ACID and a 50 µg/mL concentrated 
standard solution of ISTD, prepare (1) a 1 mL solution that is 2 µg/mL uric acid and 7 µg/mL ISTD, and 
(2) a 1 mL solution that is 4 µg/mL of analyte and 7µg/mL ISTD. SHOW CALCULATIONS FOR THE 
SOLUTION FROM POINT 1 and POINT 2.  
Use HPLC-grade DI water/0.1% formic acid for these solutions. 
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1 mL that’s 4 µg/mL uric acid and 7 µg/mL ISTD 
 
Calculations for uric acid 
 
M1V1 = M2V2 
 
(x)(50 µg/mL analyte) = (1 mL)(4 µg/mL) 
 
x = (1 mL)(4 µg/mL) / (50 µg/mL) 
 
x = 0.08 mL or 80 µL 
 
I.e. To make a 4 µg/mL concentration of uric acid from a 50 µg/mL concentration of uric acid, add 80 µl of the 50 
µg/mL concentration to an HPLC vial and fill the vial to a final volume of 1 mL 
 
Calculations for ISTD 
 
M1V1 = M2V2 
 
(x)(50 µg/mL) = (1 mL)(7 µg/mL) 
 
x = (1 mL)(7 µg/mL) / (50 µg/mL) 
 
x = 0.14 mL or 140 µl 
 
I.e. To make a 7 µg/mL concentration of ISTD from a 50 µg/mL concentration of ISTD, add 140 µl of the 50 µg/mL 
concentration to an HPLC vial and fill the vial to a final volume of 1 mL 
 
THUS, to make a 1 mL solution that is both 4 µg/mL uric acid and 7 µg/mL ISTD… (follow quantities as shown in 
Figure 3. 
 

(80 µl + 140 µL + 780 µL) = 1000 µL or 1 mL) 

   140 µL of  

50 µg/mL ISTD 

80 µL of 50 µg/mL 

uric acid 
780 µL of Water 

 
 
SOLUTION for point 2: 
 
 

 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
     

 
 

 
 
 
 

 
 

 
 
 
 
 
 
Figure 3. Sample preparation – following calculations in example 1. 
 
 
 



E.3 Estimating Limit of Detection and Limit of Determination using a  
Calibration Curve [6,7]  (Instructions refer to Agilent MassHunter software) 

 
1. In excel, list the peak area data next to their corresponding calibration solution. 

E.g.  
Concentration (µg/mL) Peak area 

0 2.1 

2 5.0 

4 9.2 

6 12.3 

8 16.9 

10 21.0 

12 24.5 

 
2. Go to the Data tab and click on the “Data Analysis” option near the top right corner of the page 

(if this option isn’t there, go to File > Options > Add-ins, then activate “Analysis ToolPak” so that 
it shows up). 

See note below on loading Analysis ToolPak in Excel 2010. 
 

3. A small box will pop up after you’ve clicked Data Analysis. Scroll down the list in the box to find 
“Regression”. Click on Regression and press OK. 
 

4. Do the following in the Regression box that pops up: input the y-range (responses), input the x-
range (concentrations), declare a confidence level (e.g. 95%), pick one box in the worksheet 
(using “output range”) for the results of this regression analysis to be displayed around, then 
click OK. The results should look like this: 

 

 
 

5. Calculate the Limit of Detection using this formula:  
 

3 * Standard Error of Y-Intercept 

Slope of the Line 
                                                    
                                                     (E.g. LOD = (3*0.3154)/1.9089 = 0.496 µg/mL) 

 
 

Slope 

Std Error of Y-Intercept 

LOD = 



6. Calculate the Limit of Quantitation using this formula: 
 

10 * Standard Error of Y-Intercept 

Slope of the Line 
 

                                   (E.g. LOQ = (10 * 0.3154)/1.9089 = 1.652 µg/mL) 

 

Note: Loading  the Analysis ToolPak for Excel 2010. 

The Analysis ToolPak is a Microsoft Office Excel add-in program that is available when you 
install Microsoft Office or Excel. 

To use the Analysis ToolPak in Excel, however, you need to load it first.  

1. Click the Microsoft Office Button , and then click Excel Options. 
2. Click Add-Ins, and then in the Manage box, select Excel Add-ins. 
3. Click Go. 
4. In the Add-Ins available box, select the Analysis ToolPak check box, and then click OK. 

a. Tip    If Analysis ToolPak is not listed in the Add-Ins available box, click Browse 
to locate it. 

b. If you get prompted that the Analysis ToolPak is not currently installed on your 
computer, click Yes to install it. 

5. After you load the Analysis ToolPak, the Data Analysis command is available in the 
Analysis group on the Data tab. 

At this points there are no instructions for Mac users.  Use Excel and formulas to do 
calculations. 

 
 

E.4 Preparation of Unknown Samples (INSTUCTOR) 
 

NOTE: The water used in these steps is HPLC DI water/0.1% formic acid 
 

1. Use synthetic urine, diluted 1:10 with water.   

2. Determine how much of unknown sample you need to prepare.  Base your determination on the 

number of students in the class.  You will need about 5 mL of the unknown sample per student.  

Using solution of standards prepared above prepare 3 samples at different concentration of 

allantoin, 6-AU, UA in the synthetic urine.   For sample preparation see example below.   

LOQ = 



3. Transfer prepared samples into glass vials with lid.  Label containers with: Sample name, 

concentration of all standards, solvent, date of preparation, name of person who prepared 

solutions.  Outdate the solutions after one year.  Place samples in the freezer until samples are 

ready to be used in the class.   

4. Give out about 5 mL of unknown sample per student 

Example of unknown samples preparation 

Note: for all the pipetting use volumetric pipettes. 

1. Standard solutions are 0.1 mg/mL of each allantoin, 6-AU, UA (see point D1 for preparation). 

2. Using 50.00 mL volumetric pipette, add 50.00 mL of each standard into one container.  Your 

standards are now diluted 1:3.  Label solution as Mix of standards, concentration of all standards 

(0.033 mg/mL allantoin, 0.033 mg/mL 6-AU, 0.033 mg/mL UA), solvent, date of preparation, 

name of person who prepared solutions.  Outdate the solutions after one year.  When you are 

done refrigerate the glass containers at -20 °C until samples are ready to be used in the class.   

3. For unknown #1: Pipette 50.00 mL of the diluted synthetic urine and 50.00 mL of the Mix of 

standards.  Now your standards will be diluted 1:2 (0.017 mg/mL allantoin, 0.0017 mg/mL 6-AU, 

0.017 mg/mL UA).   

4. Unknown samples with different concentration of each analyte can be prepared as well.  In 

point 2 above prepare mix of standards containing different concentrations of each analyte for 

example: 

5. Using a 50.00 mL volumetric pipette, add 50.00 mL of allantoin standard, next to the same 

container add 25.00 mL of 6-AU and 15.00 mL of UA (total volume 80 mL).  Your standards are 

now diluted in different ratios.  Label solution as mix of standards, concentration of all 

standards, solvent, date of preparation, name of person who prepared solutions.  Outdate the 

solutions after one year.  When you are done refrigerate the glass containers at -20 °C until 

samples are ready to be used in the class.   

6.  Prepare unknown samples as in point 3 above, calculate concentrations for each analyte 

7. Give out about 5 mL of one of the unknown samples per student 

 

       E.5 Preparation of Synthetic Urine Samples (STUDENTS) 
 
1. Obtain about 5 mL of the synthetic urine sample 

2. Filter the sample using syringe and syringe filters (Nylon 45 m) into clean and dry weighing 

bottle 



3. Using synthetic urine sample and internal standard solution (tyrosine) prepare sample for LC-MS 

analysis in HPLC vial.  Make sure that this sample contains the same concentration of tyrosine 

that your calibration solutions have. 

4. Run the sample at least 3 times through HPLC-MS. 

5. Using calibration curve that you constructed calculate concentration of assigned analyte(All, 6-

AU or UA ) in synthetic urine sample. 

 
           E.6 Example of analysis of standard solutions and urine samples 
 
 Analysis of Standard Solutions 
 
Use the examples provided below to set up LC-MS runs and to separate all 4 standards. 

 
 
 

 
 
 
 
Figure 4. EICs of allantoin, 6-aminouracil, uric acid, and tyrosine 
Peaks: 
1 Allantoin: [M+Na]+ EIC(181.0332 m/z) 
 
2 6-aminouracil: [M+H] + EIC(128.0455 m/z) 

 
3 Uric acid: [M+H] + EIC(169.0356 m/z) 

 
4 Tyrosine: [M+H] + EIC(182.0812 m/z) 

 



Analytical Method:  
 
Flow rate: 0.4 mL/min 
 
Cogent Diol™ column: 4um, 100A, 150 x 2.1mm ID, SN: C1262, Part #: 40060-15P-2, Vendor: Microsolv 

Tech Corp. 

Solvents: 

A: DI water (0.1% FA)     

B: Acetonitrile (0.1% FA) 

Gradient: 

Time (min) %B 

0.00  95 

6.00 30 

7.00 30 

8.00 95 

Post time: 4 min 

 
 
Example of analysis of the urine samples    

 
Figure 5. EICs of allantoin, 6-aminouracil, uric acid, and tyrosine 

Peaks: 
1 Allantoin: [M+Na]+ EIC(181.0332 m/z) 
 
2 6-aminouracil: [M+H] + EIC(128.0455 m/z) 

 
3 Uric acid: [M+H] + EIC(169.0356 m/z) 

 
4 Tyrosine: [M+H] + EIC(182.0812 m/z) 

 



 

Method of analysis and gradient are the same as in analysis of the standards above.  As can be 
seen in the chromatogram above there are several additional peaks at the same m/z values as 
standards.  Peaks for allantoin, 6-AU, UA and Tyr were detected by comparison to of retention 
times with the standards.   
 
 
 
      E.7 Reporting the results of the experiment 
 
Separate Excel files with a report page for the above experiment were prepared.  Students are required 
to assign peaks to analytes in the mixture (by using m/z values for [M+H]+ ions).  Students record peak 
areas for analytes and construct calibration curves in the provided excel file.  Based on the calibration 
curve students determine the concentration of one analyte in the synthetic urine sample. 



 
 
 
 
 
 



Figure 1. Labelled diagram of a typical micropipette 

Figure 2. Volume readouts for different types of micropipettes 

 
E.8 Reading Micropipettes [8] 

 
A micropipette can be set to expel a specific volume, and that volume will be displayed on a small 
rectangular window. See Figure 1 below. 
 

 
 
 
Each of the three boxes that comprise the window represent a different place value, and the place 
values depend on the type of micropipette you’re using (as shown in Figure 2).  

 
 

 
 



For instance, if you were using a 200 µL micropipette – called a P200 – the top box would represent 
the hundreds place, the middle box would represent the tens place, and the final box would 
represent the ones place. Thus, a readout of “082” (read from top to bottom) would mean that the 
pipette is set to draw 82 µL of liquid. A 10 µL pipette on the other hand – or P10 – with the same 
readout would be set to draw 8.2 µL of liquid.  

 
Micropipettes can only expel a volume accurately within a certain range. P1000s can expel 200-1000 
µL accurately, while P20s can expel 20-200 µL accurately, and so on. The range of volumes that a 
pipette should be used for is usually stated on the volumetric pipette itself. Do not use a pipette to 
expel a volume out of its accuracy range – doing so will damage the instrument.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
G. Glossary 
 

Calibrate: to calibrate is to check, adjust, or determine a measurement’s or measuring device’s 
accuracy by comparing it to a standard. 
 
Calibration Solution: a solution used to create a calibration curve that’s made by diluting a standard 
concentration to a desired concentration. 
 
Chromatography: a technique used to separate the compounds in a solution. Chromatography 
entails using a gas or liquid – aka the “mobile phase” – to carry a solution through a solid material – 
or “solid phase”. The solid phase possesses a different affinity for each compound, and this 
attraction affects the time by which the compounds travel to a detector. The compounds with the 
lowest affinity to the stationary phase travel through it the fastest and are detected first, while the 
compounds with the greatest affinity to the solid phase are detected last. 
 
Qualitative Analysis: determining the quality of the components in a sample (i.e. qualitative analysis 
is figuring out WHAT compounds are in a solution). 
  
Quantitative Analysis: determining the quantity of each component in a sample (i.e. quantitative 
analysis is figuring how MUCH of each compound is present in a solution). 
 
Limit of Detection: the lowest amount of analyte in a sample that can be observed and that is 
statistically different from the noise. 
 
Limit of Quantitation: the lowest amount of analyte in a sample that can be detected and quantified 
(how much of the compound is present). The limit of quantitation is usually greater than the limit of 
detection.  
 
Mass Spectrometry: a technique used to analyze the mass and quantity of compounds in a solution 
via their masses and charges. In mass spectrometry, a solution’s compounds are charged and guided 
to a detector by means of magnetic and electric fields. The ions are separated according to their 
mass-to-charge ratio in an analyzer by electromagnetic fields. The ion signal is processed into mass 
spectra. 
 
Noise: the random fluctuations occurring in the signal that affect the accuracy with which a 
compound is detected and quantified. 
 
Standard Solution: a solution with a known concentration of a solute. A standard solution is made 
by weighing out a specific amount of a compound and dissolving it to a certain volume.  
 
Target analyte: the compound that you have targeted for analysis. In this experiment, allantoin, 6-
aminouracil, uric acid, and triuret are the target analytes. 
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